Using Design Time Images in PeopleTools

PT 8.58
Randall Groncki

Introduction

PeopleTools has the power to deliver an image rich, modern Ul for your enterprise. Whether it’s
branding, employee photos or the millions of images for the catalog’s widgets, we can deliver the
modern Ul you need within the PeopleSoft architecture.

There are two primary image categories in PeopleSoft: Design Time images and those images uploaded
by users. This document will specifically cover the Design Time images.

Design time images are those uploaded into the App Designer when creating and modifying pages.
These images are managed objects and migratable. Though extensively used by PeopleSoft, the image
handling objects and documentation really haven’t been updated since the original version 8 tools
debuted in 2000.

Using Design Time images in fluid pages will be addressed it its own document and not in the scope of
this document.
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Viewing design images currently on your system
PeopleSoft delivers thousands of images with the different applications. These are stored in the system
as Image Objects in the Content Tools tables
e PSCONTDEFN
o Content Definition Table
o Look for ContType =1 for images
o PSCONTENT
o Table that holds the actual images
o Also: scripts, XML and CSS (ContTypes 4 & 9)

Unfortunately, there is no one delivered place to view the available images in either PeopleTools or the
online application. Some of the tools do provide a preview of the image AFTER you have chosen the
image to use, but nothing to aid in selecting the correct image other than the descriptive name.

We have created a custom component to view all design time images. Download the image viewing
component at our GitHub site: https://github.com/PeopleToolsTechTips/PT3-E011-Design-Time-Images

Design Time Images

*Image Type All Images A
Image Name PS> 3
Images
‘E‘ ‘I‘ ‘I‘ 1881-1900 of 2087 w ‘I ‘I‘
—_— View 100
Image Name Format
1881 PS_SUBMITTED_APPLICATION_ICN JPG =
1322 PS_SUBMITTED_APPLICATION_S_FL svg &
1223 PS_SUCCESSION_OPTIONS_32 ICN gif 8
1884 P5_SUCCESSOR_ICN gif &
1825 PS_SUCCESS L FL svg
1836 PS_SUCCESS RES S FL avg (/]
1987 PS_SUCCESS_S_FL svg ©
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How PeopleTools delivers images to the browser

A primary challenge with images is that the application does not provide the image to the user’s
browser in the HTML as it can with most other elements such as text, JavaScript and CSS. Rather the
application places the image in a known location of the web server and provides the browser a link to
that location.

If the architecture contains multiple Web and App servers behind a load balancer, we can’t know ahead
of time where that image is going to be for the user... and the next user after that.

Browser gets Images and objects from the Web Server’s Cache
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When an image is called for at runtime, the App Server places the designated image in the web server’s
cache and then provides a link to that image in the HTML delivered to the user’s browser.

As developers, we never need to pre-stage images on web or file servers. This is bad practice since it

would create a versioning and ongoing maintenance tasks. Instead, the architecture handles image
management for us.
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Primary Image Types
In PeopleSoft HCM Application on PeopleTools 8.58, there are 8 distinct types of images in the content

table:

Type
BMP
DIB
GIF
JPG
PNG
SVG

Many of the images and formats are artifacts of PeopleSoft applications from many years (decades) ago.

Format

Windows Bitmap
Device-Independent Bitmap
Graphics Interchange Format
Joint Photographic Experts Group
Portable Network Graphics
Scalable Vector Graphics

Today, we commonly use three image formats:

Format
PNG

JPG

SVG

Common Use

Best for images with large, uniformly colored areas. Generally, computer generated
images such as logos and page graphics.

*Lossless compression.

Common for photographs
* Lossy Compression

Scripted (XML) for web graphics
Preferred image type for Navigation Tile Icons
*No Compression

Fun image search: find the different PeopleSoft and Oracle logos throughout the years still in the image
catalog. The original PeopleSoft logo is named “PTNUI_TEMP”
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Uploading new images
Design Time images are PeopleTools managed Objects.

We add them in the App Designer. For this example, we will add an image for “Sparky”, which we
found on the web.

First, acquire the image and place it somewhere convenient on your machine.

In App Designer, click on File > New, and then choose image as the definition type:

ﬁ!—;; cation Designer - PSHRDM37 - X_PT3_011_DESIGN_TIME_IMAGES - X_DES_TIME_IMG
File Edit View Insett Build Debug Tools Layout Go Window Help

beHg & 52 = 8 @ E B
B0 —

@ X_PT3_011_DESIGN_TIME_IMAGES
E| £ Components lew Definition
. @23 X_DES_TIME_IMG (GBL)

£ Menus Approval Rule Set N oK

Buziness Interink
E X_PT3_IMAGES Business Process

: 5 Pages Companent Cancel

Companent [nterface
. ¥_DES_TIME_IMG o
Ea Records File: Layout

k=3 X_IMAGE_WRK File Feference
=8 HTHL

Menu

Find your image. Ensure the file type is correctly set to your image type. It defaults to JPG.

'40& BId =% @IaF0:

D"
:’:; «— - “ 011 Image... » Graphics v o corch Graph
i Organize v Mew folder = " | 0
PSoft Stuff " Name
3

& PT3_EO11_complex_network

000 Base Video Intro Exit &| PT3_E011_DesignTimelmageViewer

Episodes |&] PT3_EOT1_NetworkCombened
001 Component Navigation |&] PT3_EDT]_New_Image 01
002 Create Excel Templates for Bl Publisher 8] PT3_€011_simple_network
003 Create XML Fide with Rowsets olispecty. 248
004 BI Publisher with PeopleCode v, % 2
File name: | sparky_248 ‘ PNG Files (*.PNG) =
Open Cancel

Your object will open in the workspace with a default name. Some of the image formats (PNG, JPG) will
display in the object. Sometimes the image will not display should it be too large or a format
unsupported for display in the App Designer (SVG).
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If the image is larger than 32K, the system will generate a warning. Some DB systems will not support

images larger than 32K.

Save your new image object: File > Save

File Edit View Insert Build Tools Go Window Help

DSEG & 3
@ X_PT3_011_DESIGN_TIME_IMAGES i .,_j =R
=23 Components =

-2 X_DES_TIME_IMG (GBL)
25 Menus

i X_PT3_IMAGES

5) Pages

¢ @15 X_DES_TIME_IMG
Ea Records

-85 X IMAGE_WRK

Save As

Save Mame As:

[#_SPaRKY

|

The system will prompt you for the image properties

Image Properties

Gereral e

==

Description:

Conmments:

Owner 1D: | PeopleT ools Dermao

Lazt Updated

General  Use

Image Mame:

Image Size:  200x200

Image URL

[ Mirrar this image in right-to-lsft contests
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On the “Use” tab, you can see more details about your image
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Image Use Controls

Image URL
Store the image on a file server rather than in the database. This URL points to the image
location for the system to retrieve at run time.

Mirror this image in right-to-left contexts
Flip the image horizontally in languages that read right to left.

Placing images on a page
Fluid page images are outside the scope of this document. Fluid images will be addressed in its own
paper and how to video. This document specifically speaks to Classic and Classic Plus pages.

There are four primary ways to place an image on a page
1. Static Image Page Control
2. HTML Area with image declared as a constant value in the properties dialog box
3. HTML Area with image declared dynamically through PeopleCode
4. Button

Static Image Page Control
Add a static image to the page where you want your image
Open the Properties box for the Static Image

Label Tab

Static Image Properties

Label  Gereral Fluid
Alt tag far image

Label Type: | Text -

Label ||nfolmati\re Label |
Image

Image 1D:  [%_SPARKY “ B

Tope: Width Height:
Image Fornat / Size

@ Scale () Size

Width: Height

Reset to actual image size

(]9

The “Alt Tag” group box controls the hover text for the image.
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The “Image” Group Box chooses the image object using the “Image Id” field. The Type and size fields
will default from the selected image object properties. These are not changeable. This image will
display if it is a type the App Designer is able to show.

The “Image Format / Size” group box allows the designer to change the size of the image on the page.
e Scale allows to change the size of the image on a scale.
e Size presents the image in at its native dimensions (width & height do not apply)

HTML Areas

The “%Image () ” HTML metatag is used with HTML areas to pull the image into the control at runtime.

The App Servers will use this metatag to place the correct image in the Web Server cache and replace
the metatag with the correct html pointer to that image.

In the example of our Sparky image object named “X_SPARKY”, you would reference like this:
<img src=%Image (X SPARKY) />
Since it is an HTML area, you can use additional styling parameters.

<img src=%Image (X SPARKY) width=75px; height=75px/>

HTML Area with image declared as a constant value in the properties dialog box
Add an HTML Area to the page where you want your image.
Open the control Properties and select the “HTML” Tab

In the “Value” group box, choose “Constant”.
Put the HTML reference using the ”$Image () 7 metatag in the dialog box.

HTML Label General Fluid

Walue
() Field  (®) Constant CIHTHL Tags Only

Recard Marme:

Field Mame:

<img src=Almagef+_PT3 BADGE] width=7hpx; height=7hpsss

JRespond Only Once
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HTML Area with image declared dynamically through PeopleCode
Add an HTML Area to the page where you want your image.
Open the control Properties and select the “HTML” Tab

In the “Value” group box, choose “Field”
Place a Record and Field in the corresponding boxes. This is most often a Derived Work Record field.

HTML Label (General Fluid

Walue

@ Field () Constant [JHTML Tags Onlw
Record Name: |X_IMAGE_WRK v]
FieldName: | HTMLAREA ~]

[ 1Respond Only Once

Using PeopleCode, place the HTML in that Record.Field value for the image.

&Rec_X IMAGE WRK.HTMLAREA.Value = "<img src=%TImage (X PT3 BADGE) width=50px;
height=50px/>";

The image can by dynamically changed at runtime to reflect information or changes in the system.
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Using Images in a button
Button controls can use images instead of labels to convey more meaning or visual shortcut in the UL.

Add a button to your page. Fill out the “Type” tab in the Properties dialog box

Push Button/Hyperlink Properties

Tope  Label Use General  Fluid

Type
(®) Push Button () Hyperlink. () &ction Widget

Destination: PeopleCode Command ~
Record Name: | %_IMAGE_WRK v]
Field Name: | VIEW_PB v
Shyle: e Default 5 i |

On the Label Tab Choose “Image” for Label Type
Push Button/Hyperlink Properties

Type Label Use  General Fluid

Label Type Label Image Format / Size

() Temt (® Image [1Bath (®) Scale (0 Size Width:
Label Size Reset to actual image size = Height:

() Small Image () Large Image Label Image

() Standard Test (®) Custom Image 10: }::: > |

width: | 400) Height: | 400
Al tag for image
Type: RFT Long ~
Wiew Status and Fesults
On Mouze -

LabelID: e 150 Default Label == ~ Over:
Contest: | |

In the “Label Image” group box on the right side of the properties box, choose the image in the “Image
ID” field. The width and height fields will default from the choses image object’s properties.

In the “Label Size” group box, choosing “Small Image” or “Large Image” will have no affect on size in
Classic and Classic Plus rendering. The image will render on the page at its native size. For general

reference, the small button is supposed to be 16x16 pixels while the large button is 32x32 pixels.

Choosing “Custom” label size and then using the “Scale” control on the right side of the Properties box
will allow you to render the image at a different size than native.

The “Small Image” and “Large Image” controls along with the “Both” option for label type to work with
fluid pages.

The “Alt tag for image” group box allows you to define the hover text for the button.
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Tile Images

Both the Tile Wizard and the CRef Fluid Page require SVG images for Tile icons. Each has a prompt view
that limits the user to only images uploaded as type SVG. Attempting to place another image object
that is not type SVG will result in a page error.

The Tile packages will resize an image that is too large for a tile to fit the given tile space. It will not
increase the size of a small image to fit the tile size.

Since an SVG image is just an XML File, you will need a Graphics Software that can create or convert
images to type SVG such as Adobe lllustrator. MicroSoft Paint does not have the ability to create or edit
SVG images. There are online web-based utilities to convert PNG, GIF and other image formats into
SVG files with varying decrees of success.

AConvert.com (PNG to SVG - Convert image online (aconvert.com) seemed to work fairly well.

Once you have your SVG Image, upload it into App Designer just as you would any other image. Itis
then available to the Content Refs as a tile image.

Use the Structure and Content component or the Tile wizard to add an image to your tile.

General Security Fluid Attributes

Hoot = Fluid Structure Content = Fluid Pages = PeopleTools Tech Tips =

Tile Information

Image Name |EGF&WAPPROVED a

Display In | Cur Window v
Height 1 [ Autosize

Width 1 ] Resizable

Refresh Timer ]
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